5-3-2000

Stress and Thermal Analysis of the LoTEC Carrier

Scott Thomas

Follow this and additional works at: https://louis.uah.edu/honors-capstones

Part of the Heat Transfer, Combustion Commons, and the Structural Engineering Commons

Recommended Citation
https://louis.uah.edu/honors-capstones/621

This Thesis is brought to you for free and open access by the Honors College at LOUIS. It has been accepted for inclusion in Honors Capstone Projects and Theses by an authorized administrator of LOUIS.
Stress and Thermal Analysis
of the
LoTEC Carrier

Honor's Director:
Dr. Richard Modlin

Advising Professor:
Dr. Francis Wessling

Written by:
Scott Thomas
May 03, 2000
Introduction

The LoTEC carrier is being designed to transport biological experiments to the International Space Station (ISS) and store them there until they are to be performed. This is to be done without the use of power to maintain the low temperatures necessary for such a task. This leads to three main phases for the design process. First, there must be a functioning design that conforms to the known size criteria. Secondly, the LoTEC carrier must be able to make the flight into space while carrying its payload. Finally, the LoTEC carrier must accomplish the requirement of maintaining a low temperature without a power source. Once these three phases have been successfully incorporated into one design, the LoTEC carrier will be ready to fly.

Design Phase

The first phase of the design process was to draft an initial design that meets all known size criteria. Other important design considerations, such as use in a weightless environment, were also taken into account in the design process. The modern, low cost method of design is to use an integrated software package that contains the necessary solid modeling capability as well as important analysis tools. The I-DEAS™ software package was used to create solid models of the individual parts and then place these parts into an assembly. The procedures used to model these parts may be found in Appendix A. The assembly was then inspected to determine how well the parts fit together, what tolerances need to be held when the parts are manufactured, and whether the assembly will fit in the allotted space. The results of this inspection determined which of the parts needed to be modified to function properly. These steps were carried out until the design was considered satisfactory. Then the solid models were used to produce two-dimensional drawings of the parts for manufacturing purposes.
Stress Analysis Phase

The second phase of the design process is to ensure that the LoTEC carrier can undergo repeated flights to and from the ISS. The LoTEC carrier must be strong enough to endure the static and dynamic loads that will be applied under such conditions. The stress analysis portion of the I-DEAS™ software package was used to test the design before the parts were produced. The first step in using a software package for analysis was to set up simple models to which an analytical solution exists. The results from the model were compared to those from the analytical solution, and the software package yielded proper results within a very small error margin. This approach also verified that the technique used to model a simple part and perform a stress analysis on that part was correct. The same approach was then used on a small assembly. This again verified the results given by the software as well as the technique used to obtain those results. A stress analysis was then performed on important parts and subassemblies of the LoTEC carrier. The results obtained from the subassemblies were used to determine what modifications were necessary to ensure that the LoTEC carrier would endure the rigors of space flight. These modifications had to be carefully considered such that they did not affect the results from the design phase.

Results of the Stress Analysis

The first analysis was performed to verify the correctness of both the software and the procedure. A single load was placed in the center of a simply supported beam. The analytical solution for the maximum displacement\(^1\) is

\[
y = \frac{Wl^3}{48EI}
\]

The inputs for this analysis were \(W=62.4\text{ lbs}, L=18\text{ inches}, E=29.9938\times10^6\text{ psi},\) and \(I=0.0208\text{ inches}^4\). This yielded a result of \(y=9.707\times10^{-2}\text{ inches}\) for the
maximum displacement. The software exactly yielded the same result when given the same input values (see Figure C-1, Appendix C). An assembled beam of the same external dimensions was then analyzed. This beam consisted of two half-height beams stacked one on top of the other, two separate parts in the software model. An identical stress analysis was then performed on this assembly, using the same boundary conditions and loading. The resulting deformation matched the single beam analysis (see Figure C-2). The stress on the assembly was three percent lower than the single beam. The assembly beam was then modeled as one part partitioned into two half-height volumes, using the same boundary conditions and loading. Again, the deformation was the same, but the stress in this case was under two percent higher (see Figure C-3). These differences are minimal for design use and will not present a problem when the LoTEC carrier is put into use.

The second analysis performed used the same single beam, but it was supported by rigidly fixing both ends. The analytical solution for the maximum displacement in this case is

$$y = \frac{WL^3}{192EI}$$

The inputs for this solution were W=256.8 lbs, L=18 inches, E=29.9938x10^6 psi, and I=0.0208 inches^4. This yielded a result of y=9.986x10^{-2} inches for the maximum displacement. The software results were slightly different, yielding y=9.75x10^{-2} inches for the maximum displacement (see Figure C-4). This shows a difference of 2.5%. The two-part assembly beam was then calculated using the new boundary conditions and loading, and the resulting displacements again were identical for the two software outputs (see Figure C-5). The resulting stress on the assembly beam was less than one percent lower than the single beam under these conditions. The two-volume assembly beam was also calculated using the new setup. The displacement was under one percent higher and the stress was under two percent higher (see Figure C-6). These differences again are acceptable for design purposes.
These calculations show that the software had been satisfactorily verified for the displacements and stresses. The next step was to perform a stress analysis on the most vulnerable parts of the LoTEC carrier. Due to the sensitive nature of these results, they have been omitted from this report.

**Thermal Analysis**

The final phase of the design process is to ensure that the LoTEC carrier will perform its intended task: to keep its contents at 0 °C for up to a week without power. The LoTEC carrier must have sufficient insulative properties to maintain such a temperature within an environment of ambient conditions between 18.3 °C and 26.7 °C. The thermal analysis portion of the I-DEAS™ software package was used to test the design and these results were compared to results test obtained from the prototype. The print-out results of the thermal analysis may be found in Appendix B. Again, the first step in using a software package for analysis was to set up simple models to which an analytical solution exists. The results from the models were compared to those from the analytical solution, and the software package yielded proper results within a very small error margin. This approach also verified that the technique used to model a simple part and perform a thermal analysis on that part was correct. The same approach was then used on a small assembly. This again verified the results given by the software as well as the technique used to obtain those results. A thermal analysis was then performed on an assembled model of the LoTEC carrier. The results obtained from the assembly were used to determine what modifications were necessary to ensure that the LoTEC carrier would maintain the proper interior conditions. These modifications had to be carefully considered such that they did not affect the results from the design phase or the stress analysis phase.
Results of the Thermal Analysis

Similar to the stress analysis, the thermal analysis began with an attempt to verify the software package and the procedure used. The first test used was to model a simple cylinder. A temperature of 0 °C (32 °F) was placed on one end while a temperature of 30 °C (86 °F) was placed on the other end. A steady-state analysis was performed, and the results showed an expected temperature distribution along the cylinder (see Figure D-1, Appendix D). The next step was to join two materials together and perform an analysis. A rectangular beam was divided in the center of its span into two materials (see Figure D-2). The material toward the back was given a coefficient of thermal conductivity ten times that of the forward portion. The same temperatures were assigned and the analysis performed. Again the temperature distribution results matched with expectations. However, 'gut feelings' and expectations must be verified with numerical solutions. A third test was performed, this time passing the heat through the shorter axis of the material (see Figure D-3). This setup tested a 0.34 meter by 0.16 plate, which was 0.04 meters thick (see Figure D-4). Once again the temperatures remained the same, however in this case the 30 °C temperature was assigned to the front face while the 0 °C temperature was assigned to the back face. The analysis revealed a heat transfer of 2.69 watts (see Page B-1). The numerical solution is found using:

\[ q = kA \frac{\Delta T}{\Delta x} \]

with k=0.036 W/(m K), A=0.053 m², \( \Delta T = 30 \) K, and \( \Delta x = 0.04 \) m, yielding a result of 1.54 watts. This corresponds to a 75% error, even though the pictorial results 'looked' satisfactory. A more simple test was then performed. A square plate, 1.00 m on each side by 0.10 m thick, was modeled (see Figure D-4). The same temperature difference was used, but the thermal conductivity was modified to k=0.100 W/(m K). The previous equation was again employed and the
numerical result was 30.0 watts. The analysis was performed, and the resulting heat flow was 56.03 watts. The exhibited an error of 87%. The length of the model was then doubled, and the analysis performed again (see Figure D-5). The test solution gave a result of 113.9 watts (see Page B-5), while the numerical solution was 60.0 watts. This exhibited an error of 89.9%. Due to the large and inconsistent errors obtained from the computer model, the procedure used to model the part and perform the thermal analysis was scrutinized. It was determined that the temperatures were being assigned to more than just the faces intended. These temperatures were actually being assigned to elements deep into the part. This led to a smaller value for the change in length (Δx). The smaller value in the denominator caused the results to increase significantly. The solution to this problem was to place a zero thickness layer of elements onto the appropriate faces, assign the temperatures, and then specify a solid element mesh for the part. This caused the assigned temperatures to only effect the desired faces. The two previous analyses were remodeled and the thermal analyses performed again. For the first (numerical solution of 30.0 watts), the analysis results were 30.03 watts (see Page B-7). This is an error of 0.1%. The second analysis (numerical solution of 60.0 watts) resulted in a heat flow of 60.09 watts. This is an error of 0.15%. These extremely low-error measurements verified both the new process used to model the parts and the software analysis package.

Again the next step was to apply these procedures to the LoTEC carrier and compare the results with those obtained from laboratory experiments. Once more this section will be omitted due to the sensitive nature of the results.

**Conclusion**

The design phase was successfully passed with the LoTEC carrier properly fitting into the allocated space. The stress analysis phase was completed, with the LoTEC carrier indicating that the rigors of space flight would not present a
problem. The thermal analysis phase was finished by showing that the LoTEC carrier was sufficiently insulated to maintain the required temperature. Thus, the design process has been successfully completed and the LoTEC carrier is ready for the next process of development, engineering production and physical testing.
References


Appendix A

Procedures
• Modeling a Dual Material Beam for Stress Analysis
• Start I-DEAS
• On I-DEAS Start form:
  • Enter 'Model File name'.
  • For 'Application', select 'Design'.
  • For 'Task', select 'Master Modeler'.
  • Choose 'OK'. (For a new file, the I-DEAS Warning form will read 'New
    Model File will be created.' Choose 'OK'.)
• From the 'Options' menu, select 'Units'.
  • Select the desired units system
    • English - Inch (pound f)
    • SI - Meter (newton)
  • Choose 'Zoom All'.
• Choose 'Polylines'.
• Draw rectangle to be extruded.
• Choose 'Appearance...'.
  • Select one of the dimensions, then enter.
  • For 'Dim/GD&T Standard', select 'ANSI 1982'.
  • For 'Units/Decimal places', enter desired value.
  • Choose 'Set As Default'.
  • Choose 'OK'.
• Select the other dimension, then enter.
  • Choose 'Use Default', then 'OK'.
• Choose 'Modify Entity'.
  • Select dimensions and enter desired values.
• Choose 'Isometric View'.
• Choose 'Extrude'
  • Select one line of the rectangle (The entire rectangle should then be
    highlighted.), then enter.
  • For 'Distance', enter desired value.
  • Choose 'OK'.
• Choose 'Zoom All'.
• Choose 'Draw on Face'
  • Select front face of extruded rectangle.
  • Draw a line from midpoint to midpoint on selected face.
  • Choose 'Extrude'
  • Right-click, select 'Partition' from pop-up menu.
  • Select line on face of rectangle, then enter.
    (Note: This creates one part with two volumes. Each volume should
    be meshed separately. When meshing these volumes, different
    materials may then be selected.
• Choose 'Name Part'.
  • Enter desired part name.
  • Choose 'OK'.
• From the 'File' menu, select 'Save'.

Page A-1
• Stress Analysis
  • Open beam model file.
  • Choose ‘Simulation’ application.
  • Choose ‘Boundary Conditions’ task.
  • Choose ‘Create FE Model’.
    • Choose ‘Geometry Based Analysis Only’.
    • Choose ‘OK’.
  • Choose ‘Displacement Restraint...’
    • For simple support, select bottom end lines, then enter.
    • Select ‘free’ for ‘X Translation’ and ‘Z Rotation’.
    • Choose ‘OK’.
  • Choose ‘Force...’
    • Apply force to node at center of beam.
  • Choose ‘Boundary Condition’.
    • Choose ‘Restraint Set’.
    • Highlight desired Load Set.
    • Choose ‘OK’.
  • Choose ‘Meshing’ task.
  • Choose ‘Define Solid Mesh’.
    • Select part and enter desired element length.
    • Choose ‘OK’.
  • Choose ‘Solid Mesh’.
    • Select part, then ‘Yes’ to keep automesh.
  • Choose ‘Model Solution’ task.
  • Choose ‘Solution Set’.
    • Choose ‘Create...’
      • Under ‘Output Selection...’, select desired output and ‘store’.
      • Choose ‘OK’.
    • Choose ‘OK’.
    • Choose ‘Dismiss’.
  • Choose ‘Solve’.
  • Choose ‘Post Processing’ task.
  • Choose ‘Display Template...’
    • Select ‘Lighting Effects’.
    • For ‘Results’, select ‘Maximum Principle Stresses’.
    • Choose ‘OK’.
  • Choose ‘Display’, then enter.
• Printing from IDEAS Design and Simulation Application
  • From the ‘File’ menu, select ‘Picture Files’.
  • Select ‘Create single’ and type in the desired picture file name.
  • Choose ‘OK’. A message will appear stating that the next display command will create the new picture file. Choose ‘OK’.
  • Choose ‘Redisplay’ button (bottom group of buttons, top left corner).
  • From the ‘File’ menu, select ‘Plot’.
  • Choose ‘Plot’ button (far left button in row along top of form).
  • Type in picture file name (or press the folder button next to the file field and select \[filename\].cgm file from choices).
  • Choose ‘OK’ to plot.

• Printing from IDEAS Drafting Application
  • Open file that is to be printed.
  • From the ‘File’ menu, select ‘Export’.
  • Select ‘CGM file’ as the file type (default value is ‘Symbol’). Make sure ‘CGM-Clear text’ is selected. Enter the desired picture file name.
  • Choose ‘Done’.
  • From the ‘File’ menu, select ‘Plotting’.
  • The exported file name should be automatically displayed. (If not, or to plot a previously exported picture file, press the folder button next to the file field and select \[filename\].cgm file from choices.)
  • Choose ‘OK’ to plot.
Appendix B

Thermal Analysis Print-outs
THERM TEST SLAB1
ELEMENT SIZE = 0.0254 m
SAVED AS ANALYSIS_04_24_A

I-DEAS TMG

Thermal Solver Software
MAYA Heat Transfer Technologies Ltd.

TMG/ESC Version 7.0.99 Oct 28 15:30:00 EDT 1999

+----------------------------------------------------------+
| Preparing Thermal Model - Elapsed Time: 00 min 03 sec    |
+----------------------------------------------------------+

Starting TMG Input File Build...
TMG Input File Successfully Built
Starting TMG Analysis...

Cpu time= 0.0  MAIN Module
Cpu time= 0.2  DATACH Module
Cpu time= 3.7  ECHOS Module
Cpu time= 4.6  COND Module
Cpu time= 6.0  VUFAC Module
Cpu time= 6.7  GRAYB Module
Cpu time= 7.2  MEREL Module
Cpu time= 12.6 ANP Module
Cpu time= 16.3 ANALYZER Module

Number of iterations = 2  TDmax = 0.000E+00 at element 1

Minimum temperature  = 0.000 at element 754 BACK
Maximum temperature  = 30.000 at element 744 FRONT
Average temperature  = 15.039

Heat flow into sinks  = 2.6910E+00
Heat flow from sinks  = 2.6910E+00
Heat load into elements  = 0.0000E+00
Heat flow from fluid sources to Sinks through 1-way conductances  = 0.0000E+00
Deviation from heat balance  = 4.7684E-07

Cpu time= 18.1  RSLTPOST Module
Cpu time= 19.4  End of run

Feml  TMG7.0.99 4/24/2000

Conductive conductances and capacitances will be calculated with CG method
View factors, solar view factors, convective conductances will be calculated
Radiative conductances will be calculated
Temperatures will be calculated

Cpu time= 0.2  DATACH Module
Number of nodes 1587
Number of elements 758
Number of fluid elements 0
Cpu time= 3.7  ECHOS Module
Cpu time= 4.6  COND Module
Cpu time= 6.0  VUFAC Module

** WARNING **
** Model contains no eligible radiation elements.

Cpu time= 6.7  GRAYB Module

Creating radiative couplings

** WARNING **
** No view factors present for radiative conductance calculations.
Solution elapsed time: 01 min 07 sec

+--------------------------------------------------------------------+
| END                                                                  |
+--------------------------------------------------------------------+

CPU time= 19.4

RSLTPOST Module

Cpu time= 18.1

Summary for thermal elements

Maximum heat balance deviation occurs at element 286

TDmax = 4.768E-07
Heat flow through l-way conductances = 0.000 +00
Heat flow from fluid sources to sinks = 2.961E+00
Heat flow into sinks = 2.691E+00
Heat flow from sinks = 2.961E+00

Summary of boundary elements

Average temperature = 15.039 at element 74 BACK
Maximum temperature = 286 BACK
Minimum temperature = 0.000 at element 74 FRONT

Total number of conductances = 7580
Number of linear conductances = 7580
Number of boundary elements = 1782
Number of thermal elements = 2540

No. of iterations = 2

Minimum temperature = 0.000 at element 0

Solution elapsed time: 01 min 07 sec
THERM TEST SLAB2
ELEMENT SIZE = 0.1 m
SAVED AS ANALYSIS_04_25_A

I-DEAS TMG

Thermal Solver Software
MAYA Heat Transfer Technologies Ltd.

TMG/ESC Version 7.0.99 Oct 28 15:30:00 EDT 1999

+---------------------------------------------------------------+
| Preparing Thermal Model - Elapsed Time: 00 min 02 sec          |
+---------------------------------------------------------------+

Starting TMG Input File Build...
TMG Input File Successfully Built
Starting TMG Analysis...

Cpu time = 0.0 MAIN Module
Cpu time = 0.2 DATACH Module
Cpu time = 3.4 ECHOS Module
Cpu time = 4.2 COND Module
Cpu time = 5.4 VUFAC Module
Cpu time = 6.0 GRAYB Module
Cpu time = 6.5 MEREL Module
Cpu time = 11.2 ANP Module
Cpu time = 14.7 ANALYZER Module

Number of iterations = 2
TDmax = 0.000E+00 at element 1

Minimum temperature = 0.000 at element 693 BACK
Maximum temperature = 30.000 at element 689 FRONT
Average temperature = 14.937

Heat flow into sinks = 5.6027E+01
Heat flow from sinks = 5.6027E+01
Heat load into elements = 0.0000E+00
Heat flow from fluid sources to Sinks through 1-way conductances = 0.0000E+00
Deviation from heat balance = -7.6294E-06

Cpu time = 16.3 RSLTPOST Module
Cpu time = 17.9 End of run

Feml TMG7.0.99 4/25/2000
Conductive conductances and capacitances will be calculated with CG method
View factors, solar view factors, convective conductances will be calculated
Radiative conductances will be calculated
Temperatures will be calculated
Cpu time = 0.2 DATACH Module
Number of nodes = 1507
Number of elements = 696
Number of fluid elements = 0
Cpu time = 3.4 ECHOS Module
Cpu time = 4.2 COND Module
Cpu time = 5.4 VUFAC Module

** WARNING **
** Model contains no eligible radiation elements.

Cpu time = 6.0 GRAYB Module

Creating radiative couplings

** WARNING **
** No view factors present for radiative conductance calculations.
Cpu time = 6.5  MEREL Module
Cpu time = 11.2  ANP Module
Cpu time = 14.7  ANALYZER Module
Number of elements = 2356
Total number of conductances = 6959
Number of linear conductances = 6959
Number of boundary elements = 1660
No. of iterations = 2  Tdmax = 0.000E+00 at element 1
Minimum temperature = 0.000 at element 693 BACK
Maximum temperature = 30.000 at element 689 FRONT
Average temperature = 14.937

Summary for thermal elements

Maximum heat balance deviation occurs at element 1401
Heat flow into sinks = 5.603E+01
Heat flow from sinks = 5.603E+01
Heat load into elements = 0.000E+00
Heat flow from fluid sources to sinks through 1-way conductances = 0.000E+00
Deviation from heat balance = -7.629E-06

Cpu time = 16.3  RSLTPOST Module
Cpu time = 17.5  End of run

+-------------------------------------------------+  END
| END                                              |
+-------------------------------------------------+

Solution elapsed time: 00 min 59 sec
Thermal Solver Software
MAYA Heat Transfer Technologies Ltd.

**Preparation**

```
+--------------------------------------------------------------------+
| Preparing Thermal Model - Elapsed Time: 00 min 03 sec              |
+--------------------------------------------------------------------+
```

**Starting TMG Input File Build...**

**Starting TMG Analysis...**

<table>
<thead>
<tr>
<th>Cpu time=</th>
<th>Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0</td>
<td>MAIN Module</td>
</tr>
<tr>
<td>0.2</td>
<td>DATACH Module</td>
</tr>
<tr>
<td>6.8</td>
<td>ECHOS Module</td>
</tr>
<tr>
<td>8.4</td>
<td>COND Module</td>
</tr>
<tr>
<td>11.0</td>
<td>VUFAC Module</td>
</tr>
<tr>
<td>12.4</td>
<td>GRAYB Module</td>
</tr>
<tr>
<td>13.4</td>
<td>MEREL Module</td>
</tr>
<tr>
<td>22.5</td>
<td>ANP Module</td>
</tr>
<tr>
<td>29.3</td>
<td>ANALYZER Module</td>
</tr>
</tbody>
</table>

**Number of iterations** = 2
**TDmax** = 0.000E+00 at element 1

**Minimum temperature** = 0.000 at element 1405 BACK
**Maximum temperature** = 30.000 at element 1401 FRONT
**Average temperature** = 15.004

**Heat flow into sinks** = 1.1389E+02
**Heat flow from sinks** = 1.1389E+02
**Heat load into elements** = 0.0000E+00
**Heat flow from fluid sources to sinks** = 0.0000E+00
**Deviation from heat balance** = -7.6294E-06

<table>
<thead>
<tr>
<th>Cpu time=</th>
<th>Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>32.3</td>
<td>RSLTPOST Module</td>
</tr>
<tr>
<td>34.7</td>
<td>End of run</td>
</tr>
</tbody>
</table>

**Feml**

**Conductive conductances and capacitances will be calculated with CG method**
**View factors, solar view factors, convective conductances will be calculated**
**Radiative conductances will be calculated**
**Temperatures will be calculated**

<table>
<thead>
<tr>
<th>Cpu time=</th>
<th>Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.2</td>
<td>DATACH Module</td>
</tr>
<tr>
<td>6.8</td>
<td>ECHOS Module</td>
</tr>
<tr>
<td>8.4</td>
<td>COND Module</td>
</tr>
<tr>
<td>11.0</td>
<td>VUFAC Module</td>
</tr>
</tbody>
</table>

**WARNING**
**Model contains no eligible radiation elements.**

<table>
<thead>
<tr>
<th>Cpu time=</th>
<th>Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>12.4</td>
<td>GRAYB Module</td>
</tr>
</tbody>
</table>

**WARNING**
**No view factors present for radiative conductance calculations.**
CPU time = 13.4 MEREL Module
CPU time = 22.5 ANP Module
CPU time = 29.3 ANALYZER Module

Number of elements = 4743
Total number of conductances = 14050
Number of linear conductances = 14050
Number of boundary elements = 3338

No. of iterations = 2
TDmax = 0.000E+00 at element 1

Minimum temperature = 0.000 at element 1405 BACK
Maximum temperature = 30.000 at element 1401 FRONT
Average temperature = 15.004

Summary for thermal elements

Maximum heat balance deviation occurs at element 3591
Heat flow into sinks = 1.139E+02
Heat flow from sinks = 1.139E+02
Heat load into elements = 0.000E+00
Heat flow from fluid sources to sinks through 1-way conductances = 0.000E+00
Deviation from heat balance = -7.629E-06

CPU time = 32.3 RSLTPOST Module
CPU time = 34.7 End of run

+---------------------------------------------------------------+ \\
| END | \\
+---------------------------------------------------------------+

Solution elapsed time: 01 min 29 sec
THERM_TEST_SLAB2
ELEMENT SIZE = 0.05m
SAVED AS ANALYSIS_04_26_A

I-DEAS TMG

Thermal Solver Software
MAYA Heat Transfer Technologies Ltd.

TMG/ESC Version 7.0.99 Oct 28 15:30:00 EDT 1999

+--------------------------------------------------------------------+
| Preparing Thermal Model - Elapsed Time: 00 min 04 sec             |
+--------------------------------------------------------------------+

Starting TMG Input File Build...
TMG Input File Successfully Built
Starting TMG Analysis...

Cpu time= 0.0 MAIN Module
Cpu time= 0.3 DATACH Module
Cpu time= 22.8 ECHOS Module
Cpu time= 28.8 COND Module
Cpu time= 38.0 VUFAC Module
Cpu time= 42.6 GRAYB Module
Cpu time= 45.9 MEREL Module
Cpu time= 74.4 ANP Module
Cpu time= 96.3 ANALYZER Module

Number of iterations = 2  Tdmax = 1.907E-06 at element 2082
Minimum temperature = 0.000 at element 1788 BACK
Maximum temperature = 30.000 at element 894 FRONT
Average temperature = 14.990

Heat flow into sinks = 3.0028E+01
Heat flow from sinks = 3.0028E+01
Heat load into elements = 0.0000E+00
Heat flow from fluid sources to Sinks through 1-way conductances = 0.0000E+00
Deviation from heat balance = -1.9073E-05

Cpu time= 106.9 RSLTPOST Module
Cpu time= 115.9 End of run

** WARNING **
** No view factors present for radiative conductance calculations.

Cpu time= 45.9 MEREL Module
Cpu time= 74.4 ANP Module
Cpu time= 96.3 ANALYZER Module
Number of elements = 14892
Total number of conductances = 46140
Number of linear conductances = 46140
Number of boundary elements = 8490

** WARNING **
** 125 conductances out of a total of 46140 were modified to make
** the solution more robust. For further details, please look on file REPF.

No. of iterations = 2
TDmax = 1.907E-06 at element 2082

Minimum temperature = 0.000 at element 1788 BACK
Maximum temperature = 30.000 at element 894 FRONT
Average temperature = 14.990

Summary for thermal elements

Maximum heat balance deviation occurs at element 1868
Heat flow into sinks = 3.003E+01
Heat flow from sinks = 3.003E+01
Heat load into elements = 0.000E+00
Heat flow from fluid sources to sinks through 1-way conductances = 0.000E+00
Deviation from heat balance = -1.907E-05

Cpu time = 106.9
RSLTPOST Module
Cpu time = 115.9
End of run

------------------------------------------
| END |
------------------------------------------

Solution elapsed time: 03 min 27 sec
THERMAL_TEST_SLAB3
ELEMENT_SIZE = 0.1m
SAVED AS ANALYSIS_04_27_A

I-DEAS TMG
Thermal Solver Software
MAYA Heat Transfer Technologies Ltd.

TMG/ESC Version 7.0.99 Oct 28 15:30:00 EDT 1999

| Preparing Thermal Model - Elapsed Time: 00 min 03 sec |
+-+-----------------------------------+
| Preparing Thermal Model - Elapsed Time: 00 min 03 sec |
+-+-----------------------------------+

Starting TMG Input File Build...
TMG Input File Successfully Built
Starting TMG Analysis...
Cpu time= 0.0 MAIN Module
Cpu time= 0.2 DATACH Module
Cpu time= 8.3 ECHOS Module
Cpu time= 10.6 COND Module
Cpu time= 13.8 VUFAC Module
Cpu time= 15.6 GRAYB Module
Cpu time= 16.8 MEREL Module
Cpu time= 27.9 ANP Module
Cpu time= 36.1 ANALYZER Module

Number of iterations = 2 Tmax = 0.000E+00 at element 1
Minimum temperature = 0.000 at element 936 BACK
Maximum temperature = 30.000 at element 468 FRONT
Average temperature = 17.014

Heat flow into sinks = 6.0085E+01
Heat flow from sinks = 6.0085E+01
Heat load into elements = 0.0000E+00
Heat flow from fluid sources to sinks through 1-way conductances = 0.0000E+00
Deviation from heat balance = -2.2888E-05

Cpu time= 40.6 RSLTPOST Module
Cpu time= 44.3 End of run

WARNING **
** No view factors present for radiative conductance calculations.

Creating radiative couplings

Number of nodes = 2991
Number of elements = 2340
Number of fluid elements = 0
Cpu time= 8.3 ECHOS Module
Cpu time= 10.6 COND Module
Cpu time= 13.8 VUFAC Module
Cpu time= 15.6 GRAYB Module

Creating radiative couplings

Cpu time= 16.8 MEREL Module
Cpu time= 27.9 ANP Module
Cpu time= 36.1 ANALYZER Module
Number of elements = 5472

Page B-9
Total number of conductances = 16848
Number of linear conductances = 16848
Number of boundary elements = 3132

** WARNING **
** 15 conductances out of a total of 16848 were modified to make
** the solution more robust. For further details, please look on file REPF.

No. of iterations = 2 Tdmax = 0.000E+00 at element 1
Minimum temperature = 0.000 at element 936 BACK
Maximum temperature = 30.000 at element 468 FRONT
Average temperature = 17.014

Summary for thermal elements
Maximum heat balance deviation occurs at element 1030
Heat flow into sinks = 6.009E+01
Heat flow from sinks = 6.009E+01
Heat load into elements = 0.000E+00
Heat flow from fluid sources to sinks through 1-way conductances = 0.000E+00
Deviation from heat balance = -2.289E-05

Cpu time= 40.6 RSLTPOST Module

** WARNING **
** Node heat fluxes are not calculated for this release

Cpu time= 44.3 End of run

Solution elapsed time: 01 min 42 sec
Appendix C

Stress Analysis Results
RESULTS: 3- B.C. 1, STRESS_3, LOAD SET 1
STRESS - MAX PRIN MIN: -5.50E+02 MAX: 1.36E+04
DEFORMATION: 1- B.C. 1, DISPLACEMENT, LOAD SET 1
DISPLACEMENT - MAG MIN: 2.85E-07 MAX 8.71E-02
FRAME OF REF: PART

VALUE OPTION: ACTUAL

-2.27E+02
-1.11E+03
-8.84E+02
-6.50E+02
-3.80E+03
-2.45E+03
-1.11E+03
-2.27E+02

VALUE OPTION: ACTUAL

1.36E+04
1.22E+04
1.08E+04
9.55E+03
8.35E+03
7.83E+03
6.52E+03
5.10E+03
3.86E+03
2.28E+03
8.84E+02
-2.27E+02

Figure C-1

Figure C-2

Page C-1
RESULTS: B.C. 1, STRESS_3, LOAD SET 1
STRESS - MAX PRIN MIN: -0.25E+02 MAX: 1.38E+04
DEFORMATION: B.C. 1, DISPLACEMENT_3, LOAD SET 1
DISPLACEMENT - MAG MIN: 9.02E-04 MAX: 8.71E-02
FRAME OF REF: PART

Figure C-3

RESULTS: B.C. 2, STRESS_7, LOAD SET 2
STRESS - MAX PRIN MIN: -1.31E+04 MAX: 3.28E+04
DEFORMATION: B.C. 2, DISPLACEMENT_7, LOAD SET 2
DISPLACEMENT - MAG MIN: 0.00E+00 MAX: 9.75E-02
FRAME OF REF: PART

Figure C-4

Page C-2
RESULTS: 3-B.C. 1, STRESS_3, LOAD SET 1
STRESS - MAX PRIN MIN: -1.23E+04 MAX: 3.25E+04
DEFORMATION: 1-B.C. 1, DISPLACEMENT_1, LOAD SET 1
DISPLACEMENT - MAG MIN: 0.00E+00 MAX: 0.75E-02
FRAME OF REF. PART

Figure C-5

VALUE OPTION: ACTUAL
3.25E+04
2.80E+04
2.35E+04
1.90E+04
1.48E+04
1.01E+04
5.98E+03
1.11E+03
-3.37E+03
-7.85E+03
-1.23E+04

RESULTS: 7-B.C. 2, STRESS_7, LOAD SET 2
STRESS - MAX PRIN MIN: -1.33E+04 MAX: 3.32E+04
DEFORMATION: 5-B.C. 2, DISPLACEMENT_5, LOAD SET 2
DISPLACEMENT - MAG MIN: 0.00E+00 MAX: 0.77E-02
FRAME OF REF. PART

Figure C-6

VALUE OPTION: ACTUAL
3.32E+04
2.88E+04
2.39E+04
1.93E+04
1.48E+04
9.31E+03
5.31E+03
9.92E+03
5.31E+03
8.93E+03
-3.99E+03
-8.64E+03
-1.33E+04

Page C-3
Appendix D

Thermal Analysis Results
Figure D-3

Figure D-4